
แผนการจัดการเรียนรู ้
   รายวชิา การออกแบบและเทคโนโลยี  รหัสวิชา ว30215 

ชั้นมัธยมศึกษาปีที่ 5 
 ภาคเรียนที่ 2 ปีการศึกษา 2568 

  ตามหลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน พุทธศักราช 2551 
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  ผู้สอน 
  นายเกียรติศักดิ์  ศรีเรือง 

  ต าแหน่ง ครู วิทยฐานะ ช านาญการพิเศษ 
  กลุ่มสาระการเรียนรู้วิทยาศาสตร์และเทคโนโลยี 

 
 

   โรงเรียนสตรีศึกษา 
  ส านักงานเขตพื้นที่การศึกษามัธยมศึกษาร้อยเอ็ด 

  ส านักงานคณะกรรมการการศึกษาขั้นพื้นฐาน 
  กระทรวงศึกษาธกิาร  



ค ำอธิบำยรำยวิชำ  
รำยวิชำ กำรออกแบบและเทคโนโลยี 

 
การสร้างงานแอนิเมชั่นด้วย Adobe Animate  กลุ่มสาระการเรียนรู้วิทยาศาสตร์และเทคโนโลยี 
ชั้นมัธยมศึกษาปีที่ 5     เวลา 20 ช่ัวโมง จำนวน 0.5 หน่วยกิต 
 

ศึกษาและปฏิบัติเกี่ยวกับทฤษฏีคอมพิวเตอร์กราฟิกส์ หลักการของกราฟิกส์แบบ Vector และ 
Raster ประเภทและคุณลักษณะของแฟ้มภาพกราฟิกส์ ความแตกต่างของกราฟิกส์แบบ 2 มิติ การใช้โปรแกรม
สร้างภาพกราฟิกส์แบบ  Vector และะ Raster 
 
 
 
 
  

 
 
 
 
 
 
 
 
 

 
 
 

 
 



โครงสร้ำงรำยวิชำ สรำ้งงำนแอนนิเมชั่นด้วย Adobe Animate 
ชั้นมัธยมศึกษำปีท่ี 5 

ล ำดับ
ที ่

ชื่อหน่วยกำรเรียน สำระส ำคัญ 

เวล
ำ 

(ชั่ว
โมง)  

น้ ำหนัก
คะแนน 

1 การวาดรูปและ
ลงสี 

การสร้างภาพกราฟิกใน Adobe Animate มี 2 วิธี วิธีแรกคือ
การใช้เครื่องมือ Adobe Animate สร้างข้ึนมา และวิธีที่ 2 
คือนำเข้าภาพจากภายนอก อาจเป็นภาพถ่ายหรือภาพที่สร้าง
จากโปรแกรมกราฟิกอ่ืนก็ได้ เช่น Illustrator หรือ 
Photoshop ซึ่งมีได้หลากหลายนามสกุล อาทิ .GIF .PNG 
.BMP เป็นต้น สำหรับในบทนี้เราจะกล่าวถึงการสร้าง
ภาพกราฟิกด้วยวิธีแรก นั่นคือ การใช้เครื่องมือใน Adobe 
Animate วาดรูปขึ้นมาเอง โดยเราจะกล่าวถึงหลักการพ้ืนฐาน
และการใช้เครื่องมือวาดทีละตัว 
 

2 10 

2 ซิมบอลและ
อินสแตนซ์ 

ซิมบอล (symbol) คือการนำออบเจ็กต์ที่เป็นภาพกราฟิก 
ปุ่มกด หรือมูฟวี่ มากำหนดเป็นต้นแบบ เพ่ือนำไปใช้เป็น
ส่วนประกอบในชิ้นงานโดยซิมบอลที่สร้างจะถูกเก็บไว้ใน
พาเนล LIBRARY 
 

4 10 

3 การนำเข้า
ภาพกราฟิกจาก
ภายนอก  

เราได้กล่าวไปแล้วว่าภาพกราฟิกนั้นแบ่งออกได้เป็น 2 
ประเภท คือ ภาพบิทแมป และภาพเวกเตอร์ เนื่องจาก 
Adobe Animate เป็นโปรแกรมท่ีทำงานกับภาพเวกเตอร์เป็น
หลัก ดังนั้นในบทการวาดรูป การใช้สี และการสร้างข้อความที่
ได้กล่าวไปแล้ว จึงเป็นการสร้างภาพหรือข้อความที่เป็น
เวกเตอร์ทั้งสิ้น อย่างไรก็ตามภาพเวกเตอร์มีข้อจำกัดตรงที่ไม่
สามารถแทนภาพถ่าย หรือภาพที่มีรายละเอียดสูงได้ดีนัก ใน
บางกรณีเราจึงยังต้องใช้ภาพบิทแมปในชิ้นงานที่สร้างอยู่ ซ่ึง
เราจะต้องนำเข้าภาพบิทแมปเป็นไฟล์ภาพที่สร้าง โดยใช้
โปรแกรมกราฟิกอ่ืน เช่น Photoshop นอกจากนั้นเราอาจ
พบว่าเครื่องมือใน Adobe Animate ยังไม่คล่องตัวพอที่จะ

2 10 



สร้างภาพเวกเตอร์ที่มีรายละเอียดซับซ้อนมากๆ จากศูนย์ 
ดังนั้นเราอาจจะต้องพ่ึงโปรแกรมกราฟิกสร้างภาพลายเส้น
โดยเฉพาะ เช่น Illustrator สร้างภาพเวกเตอร์ให้เสร็จแล้วจึง
นำเข้ามาใช้ในชิ้นงานต่อไป สำหรับเนื้อหาในบทนี้จะกล่าวถึง
การนำเข้าภาพกราฟิกจากภายนอกทั้งภาพบิทแมป และภาพ      
เวกเตอร 

4 เข้าใจพ้ืนฐานการ
สร้างงานแอนิเมช่ัน 

การสร้างภาพเคลื่อนไหวในโปรแกรม Adobe Animate จะ
คล้ายกับหลักการสร้างภาพยนตร์ โดยจะมีการแบ่งเนื้อหา
ทั้งหมดออกเป็นฉากย่อยๆ ที่เรียกว่าซีน (scene) และแต่ละ
ซีนจะประกอบด้วยภาพนิ่งจำนวนมากที่เราเรียกว่าเฟรม 
(frame) เมื่อนำภาพเหล่านี้มาแสดงอย่างต่อเนื่องก็จะได้เป็น
ภาพที่เคลื่อนไหว  

4 20 

5 การสร้างงานแอนิ
เมชั่น 

ในบทที่ผ่านมาเราได้เกริ่นไปแล้วว่าการสร้างภาพเคลื่อนไหว
ใน Adobe Animate นั้นทำได้อยู่ 3 วิธี คือ การสร้าง
ภาพเคลื่อนไหวแบบเฟรมต่อเฟรมที่เราต้องระบุข้อมูลทุกเฟรม
ด้วยตนเอง และการสร้างภาพเคลื่อนไหวแบบทวีน ซึ่งเราเพียง
กำหนดบางเฟรมที่สำคัเท่านั้น ส่วน Adobe Animate จะ
คำนวณและสร้างเฟรมอ่ืนๆ ให้เองโดยอัตโนมัติ และการ
เคลื่อนไหวโดยการใส่กระดูก  

8 50 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



ตำรำงโครงสร้ำงแผนกำรจัดกำรเรียนรู้ 
 

รำยวิชำ สร้ำงงำนแอนิเมชั่นด้วย Adobe Animate      ชั้นมัธยมศึกษำปีที่ 5   เวลำ  
20  ชั่วโมง 

 

หน่วยกำรเรียนรู้ 
แผนกำรจัด 
กำรเรียนรู้ 

วิธีสอน / กระบวนกำร
จัด 

กำรเรียนรู้ 
ทักษะกำรคิด 

เวลำ 
(ชั่วโมง

) 
หน่วยกำรเรียนรู้ที่ 1  
การวาดรูปและลงสี 

1. มีความรู้ความเข้าใจเกี่ยวกับ
ลักษณะของภาพกราฟิกแต่ละ
ประเภท 

2. 2. มีความรู้ความเข้าใจเกี่ยวกับ
กลุ่มเครื่องมือที่ใช้ในการวาด
ภาพกราฟิก 
3. เข้าใจและสามารถสร้างรูป
ด้วยเครื่องมือต่างๆ ได้ 

วิธีสอนโดยเน้น
กระบวนการ :  
กระบวนการปฏิบัติ 

1. ทักษะการคิด
วิเคราะห์  
2. ทักษะการคิดอย่าง 
   มีวิจารณญาณ 

2 

หน่วยกำรเรียนรู้ที่ 2  
ซิมบอลและอินสแตนซ์ 

1.1. อธิบายถึงวิธีการในการสร้างซิม
บอลได้ 
2. อธิบายถึงวิธีการในการใช้
อินสแตนซ์ได้ 

วิธีสอนโดยเน้น
กระบวนการ :  
กระบวนการปฏิบัติ 

1. ทักษะการคิด
วิเคราะห์  
2. ทักษะการคิดอย่าง 
   มีวิจารณญาณ 

4 

หน่วยกำรเรียนรู้ที่ 3  
การนำเข้าภาพกราฟิก
จากภายนอก 

1. 1. รู้จักไฟล์ภาพนามสกุลต่างๆที่
สามารถนำมาใช้งานใน Adobe 
Animate ได ้

2. 2. มีความรู้ความเข้าใจและ
สามารถนำไฟล์ภาพชนิดต่างๆ 
มาใช้งานได้ 

3. อธิบายถึงการนำเข้าภาพ
เวกเตอร์ที่สร้างจากโปรแกรมอ่ืน
ได้ 

วิธีสอนโดยเน้น
กระบวนการ :  
กระบวนการปฏิบัติ 

1. ทักษะการคิด
วิเคราะห์  
2. ทักษะการคิดอย่าง 
   มีวิจารณญาณ 

2 

 
 
 
 
 



หน่วยกำรเรียนรู้ 
แผนกำรจัด 
กำรเรียนรู้ 

วิธีสอน / กระบวนกำร
จัดกำรเรียนรู้ ทักษะกำรคิด 

เวลำ 
(ชั่วโมง

) 
หน่วยกำรเรียนรู้ที่ 4 
เข้าใจพื้นฐานการสร้าง
งานแอนิเมชั่น 

1. 1. มีความรู้ความเข้าใจและ
สามารถจัดการไทมไลน์ได้ 

2. 2. มีความรู้ความเข้าใจและ
สามารถจัดการเลเยอร์ได้ 

3. มีความรู้ความเข้าใจและ
สามารถจัดการเฟรมได้ 

วิธีสอนโดยเน้น
กระบวนการ :  
กระบวนการปฏิบัติ 

1. ทักษะการคิด
วิเคราะห์  
2. ทักษะการคิดอย่าง 
   มีวิจารณญาณ 

4 

หน่วยกำรเรียนรู้ที่ 5 
การสร้างงานแอนิเมชั่น 

1. 1. มีความรู้ความเข้าใจและ
สามารถสร้างแอนิเมชั่นแบบเฟรม
ต่อเฟรมได้ 

2. 2. มีความรู้ความเข้าใจและ
สามารถสร้างแอนิเมชั่นแบบทวีนได้ 

3. 3. มีความรู้ความเข้าใจและ
สามารถสร้างเอฟเฟ็กต์
ภาพเคลื่อนไหวด้วยมาสก์เลเยอร์ได้ 

วิธีสอนโดยเน้น
กระบวนการ :  
กระบวนการปฏิบัติ 

1. ทักษะการคิด
วิเคราะห์  
2. ทักษะการคิดอย่าง 
   มีวิจารณญาณ 

8 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ตัวช้ีวัดรายวิชา การออกแบบและเทคโนโลยี  (ว30215) 

ชั้นมัธยมศึกษาปีท่ี 5 

ข้อ
ที ่

ตัวชี้วัด 

คะแนนที่ประเมิน 

เวล
าเร

ียน
(ช
ั่วโ
มง
) 

ก่อ
นก

ลา
งภ

าค
 

กล
าง
ภา

ค 

หล
ังก
ลา
งภ

าค
 

ปล
าย
ภา

ค 

รว
ม 

1 การวาดรูปและลงสี 5 5 - - 10 2 

2 ซิมบอลและอินสแตนซ์ 5 5 - - 10 4 

3 การนำเข้าภาพกราฟิกจากภายนอก 5 5 - - 10 2 

4 เข้าใจพื้นฐานการสร้างงานแอนิเมชั่น 5 5 10  20 4 

5 การสร้างงานแอนิเมชั่น   20 30 50 8 

รวม 20 20 30 30 100 20 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 

 

1. สำระส ำคัญ/ควำมคิดรวบยอด 

การสร้างภาพกราฟิกใน Animate มี 2 วิธี วิธีแรกคือการใช้เครื่องมือ Animate สร้างข้ึนมา และวิธีที่ 2 
คือนำเข้าภาพจากภายนอก อาจเป็นภาพถ่ายหรือภาพที่สร้างจากโปรแกรมกราฟิกอ่ืนก็ได้ เช่น Illustrator 
หรือ Photoshop ซึ่งมีได้หลากหลายนามสกุล อาทิ .GIF .PNG .BMP เป็นต้น สำหรับในบทนี้เราจะกล่าวถึง
การสร้างภาพกราฟิกด้วยวิธีแรก นั่นคือ การใช้เครื่องมือใน Animate วาดรูปขึ้นมาเอง โดยเราจะกล่าวถึง
หลักการพื้นฐานและการใช้เครื่องมือวาดทีละตัว 

  

2. สมรรถนะส ำคัญของผู้เรียน 
 2.1  ความสามารถในการคิด 
    -  ทักษะการคิดวิเคราะห์ 
    -  ทักษะการคิดอย่างมีวิจารณญาณ  
 2.2  ความสามารถในการใช้ทักษะชีวิต 
    -  กระบวนการปฏิบัติ 
    -  กระบวนการทำงานกลุ่ม 
 2.3  ความสามารถในการใช้เทคโนโลยี 
 

3. คุณลักษณะอันพึงประสงค์ 
 1. มีวินัย 
 2. ใฝ่เรียนรู้ 
 3. มุ่งม่ันในการทำงาน 
 

4. ชิ้นงำน/ภำระงำน (รวบยอด) 
 แบบฝึกหัดท้ายบท 
 

5. กำรวัดและกำรประเมินผล 

หน่วยกำรเรียนรู้ที่ 1   
เร่ือง   กำรวำดรูปและลงสี  

  
 กลุ่มสำระกำรเรียนรู้วิทยำศำสตร์และเทคโนโลยี 

ชั้นมัธยมศึกษำปีที่    5       เวลำเรียน  2  ชั่วโมง 
 



1.  ค้นคว้าหน่วยการเรียน 
2.  อธิบาย ยกตัวอย่าง 
3.  แสดงวิธีการปฏิบัติในแต่ละหัวข้อการเรียนและให้นักเรียนปฏิบัติไปพร้อมกัน 
4.  สรุปบทเรียน 

 
6. กำรจัดกิจกรรมกำรเรียนรู้ 

 ก่อนเรียน 
ค้นคว้าการวาดรูปและลงสี 

 ขณะเรียน 
1. ทำแบบฝึกหัดก่อนเรียน โดยการถาม – ตอบ และให้แสดงความคิดเห็น 
2. จดบันทึก สาระการเรียนรู้  
3. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
4. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียน ที่ออกแสดงความคิดเห็นเพื่อให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

5. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
6. ทบทวนเนื้อหา 
7. ทำแบบฝึกหัดหลังเรียน 
8. ร่วมกันเฉลยแบบฝึกหัด 
 

7. สื่อ/แหล่งกำรเรียนรู้ 
1.  หนงัสือประกอบการเรียน วิชา สร้างงานแอนิเมชั่นด้วย Animate 
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 
3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
 
 
 

8. วัดผลประเมินผลประจ ำหน่วย 
1. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน

การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  



2. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
3. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 

9. กิจกรรมเสนอแนะประจ ำหน่วย 
1. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพื่อหาเทคนิค วิธีการ หรือหลักการง่ายเพื่อให้หาคำตอบ

ได้อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำ
การสอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

2. ผู้เรียนมีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
3. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
4. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับ

ความจำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพื่อเกิดความรู้ความเข้าใจอย่าง
แท้จริงไม่ใช่เกิดจากการท่องจำ 
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      ลงชื่อ...................................................ผู้ประเมิน 

                                                                                         ............../.................../................ 
 
 
 
 
 
 
 

 
 
 

 

เกณฑ์กำรตัดสินคุณภำพ 
ช่วงคะแนน ระดับคุณภำพ 

17 – 20 
13 – 16  
9 – 12  
5 – 8  

ดีมาก 
ด ี

พอใช้ 
ปรับปรุง 

 

หมำยเหตุ     ครูอาจใช้วิธีการมอบหมายให้หัวหน้ากลุ่ม 
เป็นผู้ประเมิน  หรือให้ตัวแทนกลุ่มผลัดกันประเมิน   
หรือให้มีการประเมินโดยเพ่ือน  โดยตัวนักเรียนเอง  
ตามความเหมาะสมก็ได้ 
 

เกณฑ์กำรใหค้ะแนน 
ดีมาก  = 4 
ด ี  = 3 
พอใช้  = 2 
ปรับปรุง  = 1 

แบบสังเกตพฤติกรรมกำรท ำงำนกลุ่ม 
 



เฉลยแบบฝึกหัดหน่วยท่ี  2 

ตอนที่ 1 จงท ำเครื่องหมำยวงกลมล้อมรอบตัวเลือกที่ถูกต้องที่สุด 
1. ภาพกราฟิกมีกี่ประเภท 
 ก. 2 ประเภท   ข. 3 ประเภท 

 ค. 4 ประเภท   ง. 5 ประเภท 
2. ข้อใดต่อไปนี้คือข้อดีของภาพกราฟิกชนิดบิทแมป 
 ก. ปรับ ย่อขนาดได้ตามต้องการ ข. แสดงรำยละเอียดได้ใกล้เคียงกับภำพจริง 

 ค. ไฟล์มีขนาดเล็ก  ง. ใช้เวลาในการโหลดน้อย 
3. ถ้าต้องการวาดเส้นตรงในลักษณะต่างๆ ต้องใช้เครื่องมือใด 
 ก. Line Tool    ข. Pencil Tool 

 ค. Pen Tool   ง. Oval Tool 
4. ถ้าต้องการวาดวงกลมหรือวงรี ต้องใช้เครื่องมือใด 
 ก. Line Tool    ข. Pencil Tool 

 ค. Pen Tool   ง. Oval Tool 
5. ถ้าต้องการวาดเส้นอิสระ ต้องใช้เครื่องมือใด 
 ก. Line Tool    ข. Pencil Tool 

 ค. Pen Tool   ง. Oval Tool 
6. Ink Bottle Tool เป็นเครื่องมือใช้ทำอะไร 
 ก. ระบายสี    ข. เทสี 

 ค. ใส่สีพ้ืนหลัง   ง. ใส่สีเส้นขอบ 
7. ถ้าต้องการเทลวดลายให้เป็นวงกลม ต้องตั้งค่าใน Property Inspector แบบใด 
 ก. Symmetry Brush  ข. Vine Fill 

 ค. Grid Fill   ง. Branch angle 
8. ถ้าต้องการกำหนดระยะห่างระหว่างกริดในแนวนอน จะต้องเลือกคำสั่งใด 
 ก. Horizontal spacing  ข. Pattern scale 

 ค. Vertical spacing  ง. Branch angle 
 
 
9. เครื่องมือชนิดใดใช้สำหรับคัดลอกสีพ้ืนหรือรูปแบบของลายเส้นของรูปทรงหนึ่งไปใช้กับรูปทรงอ่ืน 



 ก. Symmetry Brush  ข. Eyedropper Tool 

 ค. Eraser Tool   ง. Branch angle 
10. ข้อใดต่อไปนี้คือคีย์ลัดเพ่ือลบภาพส่วนที่ไม่ต้องการออก 
 ก. F    ข. D 

 ค. E    ง. S 

ตอนที่ 2 จงอธิบำยข้ันตอนกำรวำดรูปทรงเรขำคณิตตำมรูปแบบดังต่อไปนี้ 
1. รูปสี่เหลี่ยม  
 1. คลิกเลือก Rectangle Tool หรือ Rectangle Primitive Tool 
 2. ปรับสีและรูปแบบให้กับสี่เหลี่ยม 
 3. กำหนดความโค้งของมุมแต่ละมุม 
 4. ลากเมาส์วาดสี่เหลี่ยมตามต้องการ 
2. รูปวงกลม 
 1. คลิกเลือก Oval Tool  
 2. ปรับสีและรูปแบบให้กับรูป 
 3. ลากเมาส์วาดรูปตามต้องการ 
3. รูปวงรี  

1. คลิกเลือก Oval Primitive Tool  
 2. ปรับสีและรูปแบบให้กับรูป 
 3. ลากเมาส์วาดรูปตามต้องการ 
4. รูปหลายเหลี่ยม   
 1. คลิกเลือก PolyStar Tool  
 2. ปรับสีและรูปแบบให้กับรูปหลายเหลี่ยม 
 3. ลากเมาส์วาดรูปหลายเหลี่ยมตามต้องการ 
5. รูปอิสระ  
 1. คลิกเลือก Pencil Tool 

2. ปรับสีและรูปแบบให้กับเส้นอิสระ 
 3. วาดลายเส้นตามต้องการ 

 

 
 
 



 
 
 
 
 
 
 

 

1. สำระส ำคัญ/ควำมคิดรวบยอด 

ซิมบอล (symbol) คือการนำออบเจ็กต์ท่ีเป็นภาพกราฟิก ปุ่มกด หรือมูฟวี่ มากำหนดเป็นต้นแบบ เพ่ือ
นำไปใช้เป็นส่วนประกอบในชิ้นงาน โดยซิมบอลที่สร้างจะถูกเก็บไว้ในพาเนล LIBRARY 

 

2. สมรรถนะส ำคัญของผู้เรียน 
 2.1  ความสามารถในการคิด 
    -  ทักษะการคิดวิเคราะห์ 
    -  ทักษะการคิดอย่างมีวิจารณญาณ  
 2.2  ความสามารถในการใช้ทักษะชีวิต 
    -  กระบวนการปฏิบัติ 
    -  กระบวนการทำงานกลุ่ม 
 2.3  ความสามารถในการใช้เทคโนโลยี 
 

3. คุณลักษณะอันพึงประสงค์ 
 1. มีวินัย 
 2. ใฝ่เรียนรู้ 
 3. มุ่งม่ันในการทำงาน 
 

4. ชิ้นงำน/ภำระงำน (รวบยอด) 
 แบบฝึกหัดท้ายบท 
 
 

5. กำรวัดและกำรประเมินผล 
5.  ค้นคว้าหน่วยการเรียน 

หน่วยกำรเรียนรู้ที่ 2   
เร่ือง   ซิมบอลและอินสแตนซ์ 

  
 กลุ่มสำระกำรเรียนรู้วิทยำศำสตร์และเทคโนโลยี 

ชั้นมัธยมศึกษำปีที่    5       เวลำเรียน  4  ชั่วโมง 
 



6.  อธิบาย ยกตัวอย่าง 
7.  แสดงวิธีการปฏิบัติในแต่ละหัวข้อการเรียนและให้นักเรียนปฏิบัติไปพร้อมกัน 
8.  สรุปบทเรียน 

 
6. กำรจัดกิจกรรมกำรเรียนรู้ 

 ก่อนเรียน 
ค้นคว้าเกี่ยวกับซิมบอลและอินสแตนซ์ 

 ขณะเรียน 
9. ทำแบบฝึกหัดก่อนเรียน โดยการถาม – ตอบ และให้แสดงความคิดเห็น 
10. จดบันทึก สาระการเรียนรู้  
11. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
12. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียน ที่ออกแสดงความคิดเห็นเพื่อให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

13. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
14. ทบทวนเนื้อหา 
15. ทำแบบฝึกหัดหลังเรียน 
16. ร่วมกันเฉลยแบบฝึกหัด 
 

7. สื่อ/แหล่งกำรเรียนรู้ 
1.  หนังสือประกอบการเรียน วิชา สร้างงานแอนิเมชั่นด้วย Animate 
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 
3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
 
 
 

8. วัดผลประเมินผลประจ ำหน่วย 
4. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน

การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  
5. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 



6. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 
 

9. กิจกรรมเสนอแนะประจ ำหน่วย 
5. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพื่อหาเทคนิค วิธีการ หรือหลักการง่ายเพื่อให้หาคำตอบ

ได้อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำ
การสอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

6. ผู้เรียนมีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
7. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
8. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับ

ความจำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพื่อเกิดความรู้ความเข้าใจอย่าง
แท้จริงไม่ใช่เกิดจากการท่องจำ 
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เกณฑ์กำรตัดสินคุณภำพ 
ช่วงคะแนน ระดับคุณภำพ 

17 – 20 
13 – 16  
9 – 12  
5 – 8  

ดีมาก 
ด ี

พอใช้ 
ปรับปรุง 

 

หมำยเหตุ     ครูอาจใช้วิธีการมอบหมายให้หัวหน้ากลุ่ม 
เป็นผู้ประเมิน  หรือให้ตัวแทนกลุ่มผลัดกันประเมิน   
หรือให้มีการประเมินโดยเพ่ือน  โดยตัวนักเรียนเอง  
ตามความเหมาะสมก็ได้ 
 

เกณฑ์กำรให้คะแนน 
ดีมาก  = 4 
ด ี  = 3 
พอใช้  = 2 
ปรับปรุง  = 1 

แบบสังเกตพฤติกรรมกำรท ำงำนกลุ่ม 
 



เฉลยแบบฝึกหัดหน่วยท่ี  2 

ตอนที่ 1 จงท ำเครื่องหมำยวงกลมล้อมรอบตัวเลือกที่ถูกต้องที่สุด 
1. ซิมบอลจะถูกจัดเก็บไว้ในส่วนใด 
 ก. Library    ข. Scene 

 ค. Time Line   ง. Instance 
2. เมื่อมีการแก้ไขซิมบอลในไลบรารี่เดิม จะส่งผลต่อสิ่งใด 
 ก. ไม่ส่งผลกระทบกับตัวต้นฉบับ  ข. ทุกอินสแตนซ์เปลี่ยนตำม 

 ค. เกิดการทำสำเนาซิมบอลขึ้น  ง. ไม่สามารถแก้ไขซิมบอลได้อีกต่อไป 
3. ข้อใดต่อไปนี้ไม่ใช่ข้อดีของการใช้ซิมบอลสร้างชิ้นงาน 
 ก. สำมำรถก ำหนดภำพนั้นเป็นซิมบอลได้ทันที  ข. ไม่ต้องสร้างภาพซิมบอลใหม่ 

 ค. ช้ินงานมีขนาดเล็กลง    ง. ภาพที่ได้มีความคมชัด 
4. ถ้าต้องการสร้างซิมบอลให้มีลักษณะเป็นภาพเคลื่อนไหวจะต้องเลือกซิมบอลประเภทใด 
 ก. Animation    ข. Movie clip 

 ค. Graphic   ง. Button 
5. วิธีการใดเป็นวิธีสร้างซิมบอลที่ง่ายที่สุด 
 ก. แปลงออบเจ็กต์ที่สร้ำงไว้แล้ว ข. เลือกออบเจ็กต์ใหม่ขึ้นมา 

 ค. นำอินสแตนซ์ไปใช้บนสเตจ ง. ทำสำเนาซิมบอลมาไว้บนสเตจ 
6. อินสแตนซ์เป็นการทำสิ่งใดกับซิมบอล 
 ก. การคัดแยกสำเนา   ข. กำรท ำส ำเนำ 

 ค. การลบสำเนา   ง. การสร้างซิมบอล 
7. ทุกข้อต่อไปนี้เป็นการแก้ไขคุณสมบัติของอินสแตนซ์ ยกเว้นข้อใด 
 ก. ปรับตำแหน่งที่วางบนสเตจ   ข. ปรับแต่งสีของอินสแตนซ์ 

 ค. ปรับค่ำควำมละเอียดของซิมบอล ง. ปรับความกว้างและความสูงของอินสแตนซ์ 
8. หากต้องการปรับแต่งความมืด ความสว่างให้กับอินสแตนซ์ จะต้องเลือกคำสั่งใด 
 ก. Alpha     ข. Advanced 

 ค. Tint    ง. Brightness 
 
 
9. หากต้องการปรับแต่งความโปร่งใสให้กับอินสแตนซ์ จะต้องเลือกคำสั่งใด 



 ก. Alpha     ข. Advanced 

 ค. Tint    ง. Brightness 
10. เราจะสังเกตเห็นผลการนับจำนวนการใช้งานซิมบอลจากส่วนใด 
 ก. Unused Item     ข. Time Line 

 ค. Break Apart   ง. Use Count 

ตอนที่ 2 จงตอบค ำถำมต่อไปนี้ 
1. จงบอกถึงข้อดีของการนำซิมบอลมาใช้ในการสร้างงาน 
 ช่วยคุมภาพต้นแบบที่ใช้ในชิ้นงานได้ คือ แทนที่จะต้องใช้ภาพเดิมซ้ำๆ กัน เราสามารถกำหนดภาพนั้น
เป็นซิมบอลและนำอินสแตนซ์ไปใช้บนสเตจได้ ทำให้ไม่ต้องสร้างภาพนั้นบ่อยๆ ส่งผลให้ชิ้นงานมีขนาดเล็กลง
และทำงานได้รวดเร็วกว่าเดิม  
 
2. ซิมบอลมีกี่ประเภท แต่ละประเภทต่างกันอย่างไร จงอธิบาย 

 ซิมบอลมีอยู ่3 ประเภท โดยจะมีหน้าที่แตกต่างกันไป ได้แก่ 

 Graphic คือซิมบอลที่เป็นภาพนิ่ง 

 Movie clip คือซิมบอลที่แสดงภาพเคลื่อนไหวได้ 

 Button คือซิมบอลที่เป็นลักษณะปุ่มกด 
 
 
3. จงอธิบายวิธีการแยกอินสแตนซ์ออกจากซิมบอลด้วย Break Apart อย่างคร่าวๆ 
 วิธีการแยกอินสแตนซ์ออกจากซิมบอลด้วย Break Apart สามารถทำได้ดังนี ้
 1. คลิกเลือกอินสแตนซ์ที่ต้องการเปลี่ยนเป็นออบเจ็กต์ 
 2. เลือกคำสั่ง Modify->Break Apart (หรือกดคีย์ลัด <Ctrl+B>) 

3. อินสแตนซ์กลายเป็นออบเจ็กต์ธรรมดา ซึ่งเราใช้เครื่องมือปรับแต่ง รูปทรงใน Animate แก้ไขได ้
 
4. จงอธิบายถึงวิธีการแก้ไขซิมบอล อย่างคร่าวๆ 
 วิธีการแก้ไขซิมบอล สามารถทำได้ดังนี้ 
 1. คลิกขวาที่ซิมบอลที่ต้องการแก้ไข 
 2. เลือกคำสั่ง Edit  
 3. เข้าสู่โหมดการแก้ไขซิมบอล 
 4. ทำการแก้ไขซิมบอล 



 5. เมื่อแก้ไขซิมบอลเสร็จสิ้นคลิกเพ่ือกลับสู่หน้าจอแสดงสเตจ 
 6. สังเกตว่าอินสแตนซ์ที่สร้างจากซิมบอลจะเปลี่ยนไปตามการแก้ไขซิมบอลทันที 
 
 
 
5. การปรับแต่งอินสแตนซ์ที่วางอยู่บนสเตจทำได้กี่วิธี อะไรบ้าง 
 การปรับแต่งอินสแตนซ์ที่วางอยู่บนสเตจทำได้ 3 วิธี ดังนี้ 

• ปรับความกว้างและความสูงของอินสแตนซ์ 

• ปรับตำแหน่งที่วางบนสเตจ 
• ปรับแต่งสีของอินสแตนซ์ 

 
6. นอกจากการสร้างซิมบอลขึ้นมาเองแล้ว เราสามารถนำซิมบอลจากไหนมาใช้งานได้อีกบ้าง 

 นอกจากการสร้างซิมบอลขึ้นมาเองแล้ว เราสามารถนำซิมบอลากซิมบอลสำเร็จรูปที่มีอยู่ในโปรแกรม 
Animate หรือจากไฟล์ชิ้นงานอื่นมาใช้งานได้ 
 
7. การนำซิมบอลในไฟล์อื่นมาใช้มีกี่วิธี อย่างไรบ้าง จงอธิบาย 
 การนำซิมบอลในไฟล์อื่นมาใช้มี 2 วิธี ดังนี้ 

 วิธ ีท ี่ 1 เป ิดไฟล์ช ิ้นงานเด ิมเฉพาะส่วนท ี่เป ็น  Library ได ้ด ้วยคำสั่ง File->Import->Open 
External Library... หรือกดคีย์ลัด <Ctrl+Shift+O> และเลือกไฟล์ชิ้นงาน .fla ได ้ 

 วิธีที่ 2 เปิดไฟล์ .fla ที่มีซิมบอลที่ต้องการสร้างชิ้นงานหลายไฟล์พร้อมกัน แล้วคลิกเลือกที่ช่อง
เลือกชุดของพาเนล Library เพ่ือเรียกใช้ซิมบอลของอีกไฟล์หนึ่งได้ 

 
 

  

 
 
 
 
 
 
 



 
 
 
 
 
 
 

 

1. สำระส ำคัญ/ควำมคิดรวบยอด 

 เราได้กล่าวไปแล้วว่าภาพกราฟิกนั้นแบ่งออกได้เป็น 2 ประเภท คือ ภาพบิทแมป และภาพเวกเตอร์ 
เนื่องจาก Animate เป็นโปรแกรมท่ีทำงานกับภาพเวกเตอร์เป็นหลัก ดังนั้นในบทการวาดรูป การใช้สี และการ
สร้างข้อความที่ได้กล่าวไปแล้ว จึงเป็นการสร้างภาพหรือข้อความที่เป็นเวกเตอร์ทั้งสิ้น อย่างไรก็ตามภาพ
เวกเตอร์มีข้อจำกัดตรงที่ไม่สามารถแทนภาพถ่าย หรือภาพที่มีรายละเอียดสูงได้ดีนัก ในบางกรณีเราจึงยังต้อง
ใช้ภาพบิทแมปในชิ้นงานที่สร้างอยู่ ซึ่งเราจะต้องนำเข้าภาพบิทแมปเป็นไฟล์ภาพที่สร้างโดยใช้โปรแกรมกราฟิก
อ่ืน เช่น Photoshop นอกจากนั้นเราอาจพบว่าเครื่องมือใน Animate ยังไม่คล่องตัวพอที่จะสร้างภาพ
เวกเตอร์ที่มีรายละเอียดซับซ้อนมากๆ จากศูนย์ ดังนั้นเราอาจจะต้องพ่ึงโปรแกรมกราฟิกสร้างภาพลายเส้น
โดยเฉพาะ เช่น Illustrator สร้างภาพเวกเตอร์ให้เสร็จแล้วจึงนำเข้ามาใช้ในชิ้นงานต่อไป สำหรับเนื้อหาในบท
นี้จะกล่าวถึงการนำเข้าภาพกราฟิกจากภายนอกท้ังภาพบิทแมป และภาพเวกเตอร์ 

 

2. สมรรถนะส ำคัญของผู้เรียน 
 2.1  ความสามารถในการคิด 
    -  ทักษะการคิดวิเคราะห์ 
    -  ทักษะการคิดอย่างมีวิจารณญาณ  
 2.2  ความสามารถในการใช้ทักษะชีวิต 
    -  กระบวนการปฏิบัติ 
    -  กระบวนการทำงานกลุ่ม 
 2.3  ความสามารถในการใช้เทคโนโลยี 
 
 
 
3. คุณลักษณะอันพึงประสงค์ 
 1. มีวินัย 

หน่วยกำรเรียนรู้ที่ 3   
เร่ือง   กำรน ำเข้ำภำพกรำฟิกจำกภำยนอก  

 กลุ่มสำระกำรเรียนรู้วิทยำศำสตร์และเทคโนโลยี 
ชั้นมัธยมศึกษำปีที่    5       เวลำเรียน  2  ชั่วโมง 

 



 2. ใฝ่เรียนรู้ 
 3. มุ่งม่ันในการทำงาน 
 

4. ชิ้นงำน/ภำระงำน (รวบยอด) 
 แบบฝึกหัดท้ายบท 
 

5. กำรวัดและกำรประเมินผล 
9.  ค้นคว้าหน่วยการเรียน 
10.  อธิบาย ยกตัวอย่าง 
11.  แสดงวิธีการปฏิบัติในแต่ละหัวข้อการเรียนและให้นักเรียนปฏิบัติไปพร้อมกัน 
12.  สรุปบทเรียน 

 

6. กำรจัดกิจกรรมกำรเรียนรู้ 
 ก่อนเรียน 

ค้นคว้าเกี่ยวกับการนำเข้าภาพกราฟิกจากภายนอก 

 ขณะเรียน 
17. ทำแบบฝึกหัดก่อนเรียน โดยการถาม – ตอบ และให้แสดงความคิดเห็น 
18. จดบันทึก สาระการเรียนรู้  
19. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
20. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียน ที่ออกแสดงความคิดเห็นเพื่อให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

21. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
22. ทบทวนเนื้อหา 
23. ทำแบบฝึกหัดหลังเรียน 
24. ร่วมกันเฉลยแบบฝึกหัด 
 
 

7. สื่อ/แหล่งกำรเรียนรู้ 
1.  หนังสือประกอบการเรียน วิชา สร้างงานแอนิเมชั่นด้วย Animate 
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 



3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
 

8. วัดผลประเมินผลประจ ำหน่วย 
7. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน

การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  
8. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
9. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 

9. กิจกรรมเสนอแนะประจ ำหน่วย 
9. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพื่อหาเทคนิค วิธีการ หรือหลักการง่ายเพื่อให้หาคำตอบ

ได้อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำ
การสอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

10. ผู้เรียนมีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
11. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
12. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับ

ความจำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพื่อเกิดความรู้ความเข้าใจอย่าง
แท้จริงไม่ใช่เกิดจากการท่องจำ 

 
 
   
 
 
 
 
 
 
 
 
 
 
 



 

 
 

ล ำดับ
ที ่

ชื่อ – สกุล 
ของผู้รับกำร

ประเมิน 

ควำมร่วมมือ 
กำรแสดง

ควำมคิดเห็น 
กำรรับฟัง

ควำมคิดเห็น 
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      ลงชื่อ...................................................ผู้ประเมิน 
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เกณฑ์กำรตัดสินคุณภำพ 
ช่วงคะแนน ระดับคุณภำพ 

17 – 20 
13 – 16  
9 – 12  
5 – 8  

ดีมาก 
ด ี

พอใช้ 
ปรับปรุง 

 

หมำยเหตุ     ครูอาจใช้วิธีการมอบหมายให้หัวหน้ากลุ่ม 
เป็นผู้ประเมิน  หรือให้ตัวแทนกลุ่มผลัดกันประเมิน   
หรือให้มีการประเมินโดยเพ่ือน  โดยตัวนักเรียนเอง  
ตามความเหมาะสมก็ได้ 
 

เกณฑ์กำรให้คะแนน 
ดีมาก  = 4 
ด ี  = 3 
พอใช้  = 2 
ปรับปรุง  = 1 

แบบสังเกตพฤติกรรมกำรท ำงำนกลุ่ม 
 



เฉลยแบบฝึกหัดหน่วยท่ี  7 

ตอนที่ 1 จงท ำเครื่องหมำยวงกลมล้อมรอบตัวเลือกที่ถูกต้องที่สุด 

 
1. ไฟล์ภาพชนิดใดที่ Animate ไม่สามารถนำเข้าได้ 
 ก. psd     ข. tif 

 ค. png    ง. Bmp 

<น ำเข้ำได้ทุกข้อ> 
2. ไฟล์ภาพที่มีนามสกุล .fh7 เป็นไฟล์ภาพชนิดใด 
 ก. Photoshop    ข. AutoCAD 

 ค. Freehand   ง. Bitmap 
3. ถ้าต้องการบีบอัดภาพที่มีรายละเอียดมากจะต้องเลือกทำการบีบอัดแบบใด 
 ก. None     ข. AutoCAD 

 ค. Lossy    ง. Zip 

<ไม่มีคำตอบ> 
4. ถ้าต้องการให้ไฟล์ภาพ PSD ที่นำเข้า ถูกจัดวางภาพบนสเตจให้ตรงกับมุมซ้ายของสเตจพอดี จะต้องตั้งค่าท่ี
คำสั่งใด 
 ก. Place layer at original position  ข. Merge Layers 

 ค. Convert Layer to  ง. Set stag to same size as Photoshop canvas 

 
5. ข้อใดต่อไปนี้ไม่ได้เป็นวิธีการแก้ไขภาพบิทแมทใน Animate 
 ก. ให้ Animate เรียกใช้โปรแกรมกราฟิกอ่ืนมาแก้ไข 
 ข. แปลงภำพบิทแมทให้เป็นภำพรำสเตอร์ 
 ค. ใช้เครื่องมือใน Animate แก้ไขภาพ    

 ง. แปลงภาพบิทแมปให้กลายเป็นภาพเวกเตอร์ 

 

 
6. ถ้าต้องการแก้ไขภาพบิทแมปโดยใช้คำสั่ง Break Apart จะต้องทำสิ่งใดเป็นสิ่งแรก 
 ก. กำหนดจุดที่ต้องการแก้ไข  



 ข. แปลงภาพบิทแมทให้เป็นภาพเวกเตอร์ 
 ค. ใช้เครื่องมือใน Animate แก้ไขภาพ    

 ง. แยกส่วนภำพบิทแมปก่อน 
 
 
 
7. เหตุใดภาพถ่ายจึงไม่เหมาะที่จะแก้ไขภาพด้วยวิธีการแก้ไขภาพบิทแมปโดยแปลงภาพให้เป็นเวกเตอร์ 
 ก. จะท ำให้ภำพที่ได้มีขนำดให ่ขึ้น  ข. จะทำภาพที่ได้ภาพที่ได้มีขนาดเล็กลง 

 ค. จะเกิดการบีบอัดของภาพมาก           ง. จะทำให้ภาพแตก 

 
8. ถ้าเราต้องการใช้ภาพบิทแมปเป็นสีพ้ืน จะต้องใช้เครื่องมือใดเพ่ือดึงภาพบิทแมปให้เป็นสีพ้ืน  
 ก. Brush Tool    ข. Eyedropper Tool 

 ค. Symmetry Brush  ง. Branch angle 

 
9. ถ้าต้องการนำเข้าภาพซิมบอลในไฟล์ Illustrator เข้ามาจะต้องตั้งค่าที่ส่วนใด 
 ก. Convert Layer to   ข. Place object at original position 

 ค. Import unused symbols ง. Import as a single bitmap image 

 
10. ถ้าต้องการเลือกนำภาพเข้ามาเป็นภาพบิทแมปเพียงภาพเดียว โดยภาพในเลเยอร์ทั้งหมดจะถูกรวมและ
แปลงให้เป็นภาพบิทแมป จะต้องตั้งค่าท่ีส่วนใด 
 ก. Convert Layer to   ข. Place object at original position 

 ค. Import unused symbols ง. Import as a single bitmap image 

 

 

ตอนที่ 2 จงตอบค ำถำมต่อไปนี้ 
1. การบีบอัดภาพทำได้กี่วิธี และแต่ละวิธีมีความแตกต่างกันอย่างไร 
 การบีบอัดภาพทำได้ 2 วิธีดังนี้ 



 Lossless ไม่มีการบีบอัดภาพ 

 Lossy มีการบีบอัดภาพ โดยกำหนดคุณภาพของภาพที่ Quality ได้ 2 แบบ คือ กำหนด
ตามท ี่กำหนดไว ้ท ี่ Publish setting (use Publish setting) และกำหนดเอง (custom) 
ตั้งแต ่0-100 

 
2. จงบอกขั้นตอนของการนำเข้าไฟล์ PSD ที่สร้างจาก Photoshop เข้ามาใช้ใน Animate อย่างคร่าวๆ 
 ขั้นตอนของการนำเข้าไฟล์ PSD ที่สร้างจาก Photoshop เข้ามาใช้ใน Animate ทำได้ดังนี้  
 1. เลือกคำสั่ง File->Import->Import to Stage...  
 2. เลือกไฟล์ PSD และคลิกปุ่ม Open 
 3. คลิกเลือกเลเยอร์ที่ต้องการกำหนดคุณสมบัติของภาพหรือข้อความ 
 4. กำหนดคุณสมบัติอ่ืนๆ  
 5. คลิกปุ่ม OK ภาพจะถูกนำเข้ามาใช้งานในโปรแกรม Animate 
 6. ถ้าเลือกการแปลงเลเยอร์แบบ Animate layers ภาพในเลเยอร์ต่างๆ จะถูกจัดวางเป็นเลเยอร์ตาม
ไฟล์์ PSD 
 7. ถ้าเลือกการแปลงเลเยอร์แบบ Keyframe ภาพในเลเยอร์ต่างๆ จะถูกจัดเป็นแต่ละเฟรม 
3. จงบอกข้ันตอนของการนำเข้าภาพเวกเตอร์ที่สร้างจาก Illustrator เข้ามาใช้ใน Animate  อย่างคร่าวๆ 
 . ขั้นตอนของการนำเข้าภาพเวกเตอร์ที่สร้างจาก Illustrator เข้ามาใช้ใน Animate ทำได้ดังนี้ 

1. เลือกคำสั่ง File->Import->Import to Stage  
    2. เลือกไฟล์ AI และคลิกปุ่ม Open 
 3. คลิกเลือกเลเยอรที่ต้องการนำเข้า และกำหนดคุณสมบัติของภาพ หรือข้อความในเลเยอร์นั้นๆ 
 4. กำหนดคุณสมบัติอื่นๆ  
 5. คลิกปุ่ม OK 
 6. ภาพจะถูกนำเข้ามาใช้งานในโปรแกรม 
 
 
4. จงบอกถึงข้อดีของวิธีการแก้ไขภาพบิทแมปโดยแปลงภาพให้เป็นเวกเตอร์ 

 ข้อดีของวิธีนี้คือ ภาพที่ได้จะมีขนาดเล็กกว่าเดิมมากเพราะถูกแปลงเป็นเวกเตอร์ แต่ไม่เหมาะกับ ภาพ
บิทแมปที่ซับซ้อน และมีสีจำนวนมาก เช่น ภาพถ่าย เพราะอาจทำให้ภาพที่ได้กลับมีขนาดใหญ่ขึ้นเพราะ
เวกเตอร์ที่ได้จะซับซ้อนมาก และกลับทำให้คุณภาพของภาพที่ได้ลดลง ซึ่งเราจะต้องปรับแต่งค่าในหน้าจอ 
Trace Bitmap เพ่ือให้ได้ผลลัพธ์ที่มีคุณภาพ และขนาดที่พอเหมาะ 
 

 



 
 
 
 
 
 
 

 

1. สำระส ำคัญ/ควำมคิดรวบยอด 

การสร้างภาพเคลื่อนไหวในโปรแกรม Animate จะคล้ายกับหลักการสร้างภาพยนตร์ โดยจะมีการแบ่ง
เนื้อหาทั้งหมดออกเป็นฉากย่อยๆ ที่เรียกว่าซีน (scene) และแต่ละซีนจะประกอบด้วยภาพนิ่งจำนวนมากท่ีเรา
เรียกว่าเฟรม (frame) เมื่อนำภาพเหล่านี้มาแสดงอย่างต่อเนื่องก็จะได้เป็นภาพที่เคลื่อนไหว  

 

2. สมรรถนะส ำคัญของผู้เรียน 
 2.1  ความสามารถในการคิด 
    -  ทักษะการคิดวิเคราะห์ 
    -  ทักษะการคิดอย่างมีวิจารณญาณ  
 2.2  ความสามารถในการใช้ทักษะชีวิต 
    -  กระบวนการปฏิบัติ 
    -  กระบวนการทำงานกลุ่ม 
 2.3  ความสามารถในการใช้เทคโนโลยี 
 
3. คุณลักษณะอันพึงประสงค์ 
 1. มีวินัย 
 2. ใฝ่เรียนรู้ 
 3. มุ่งม่ันในการทำงาน 
 

4. ชิ้นงำน/ภำระงำน (รวบยอด) 
 แบบฝึกหัดท้ายบท 
 

5. กำรวัดและกำรประเมินผล 
13.  ค้นคว้าหน่วยการเรียน 

หน่วยกำรเรียนรู้ที่ 4   
เร่ือง   เข้ำใจพื้นฐำนกำรสร้ำงงำนแอนินเมชั่น 

 กลุ่มสำระกำรเรียนรู้วิทยำศำสตร์และเทคโนโลยี 
ชั้นมัธยมศึกษำปีที่    5       เวลำเรียน  4  ชั่วโมง 

 



14.  อธิบาย ยกตัวอย่าง 
15.  แสดงวิธีการปฏิบัติในแต่ละหัวข้อการเรียนและให้นักเรียนปฏิบัติไปพร้อมกัน 
16.  สรุปบทเรียน 

 
6. กำรจัดกิจกรรมกำรเรียนรู้ 

 ก่อนเรียน 
ค้นคว้าความรู้เรื่องพ้ืนฐานการสร้างงานแอนิเมชั่น  

 ขณะเรียน 
25. ทำแบบฝึกหัดก่อนเรียน โดยการถาม – ตอบ และให้แสดงความคิดเห็น 
26. จดบันทึก สาระการเรียนรู้  
27. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
28. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียน ที่ออกแสดงความคิดเห็นเพื่อให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

29. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
30. ทบทวนเนื้อหา 
31. ทำแบบฝึกหัดหลังเรียน 
32. ร่วมกันเฉลยแบบฝึกหัด 
 

7. สื่อ/แหล่งกำรเรียนรู้ 
1.  หนังสือประกอบการเรียน วิชา สร้างงานแอนิเมชั่นด้วย Animate 
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 
3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
 
 
 

8. วัดผลประเมินผลประจ ำหน่วย 
10. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน

การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  
11. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 



12. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 
 

9. กิจกรรมเสนอแนะประจ ำหน่วย 
13. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพื่อหาเทคนิค วิธีการ หรือหลักการง่ายเพื่อให้หาคำตอบ

ได้อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำ
การสอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

14. ผู้เรียนมีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
15. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
16. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับ

ความจำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพื่อเกิดความรู้ความเข้าใจอย่าง
แท้จริงไม่ใช่เกิดจากการท่องจำ 

 
 
   
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 



 

 
 

ล ำดับ
ที ่

ชื่อ – สกุล 
ของผู้รับกำร

ประเมิน 

ควำมร่วมมือ 
กำรแสดง

ควำมคิดเห็น 
กำรรับฟัง

ควำมคิดเห็น 
กำรต้ังใจ
ท ำงำน 

กำรร่วม
ปรับปรุง

ผลงำนกลุ่ม 

รวม 
20 

คะแนน 
4 3 2 1 4  2 1 4 3 2 1 4 3 2 1 4 3 2 1 

                       
                       
                       
                       
                       
                       
                       
                       
                       
                       
                       

 
      ลงชื่อ...................................................ผู้ประเมิน 

                                                                                         ............../.................../................ 
 
 
 
 
 
 
 

 
 
 

 

เกณฑ์การตัดสินคุณภาพ 
ช่วงคะแนน ระดับคุณภาพ 

17 – 20 
13 – 16  
9 – 12  
5 – 8  

ดีมาก 
ด ี

พอใช้ 
ปรับปรุง 

 

หมายเหตุ     ครูอาจใช้วิธีการมอบหมายให้หัวหน้ากลุ่ม 
เป็นผู้ประเมิน  หรือให้ตัวแทนกลุม่ผลดักันประเมิน   
หรือให้มีการประเมินโดยเพื่อน  โดยตัวนักเรียนเอง  
ตามความเหมาะสมก็ได ้
 

เกณฑ์กำรให้คะแนน 
ดีมาก  = 4 
ด ี  = 3 
พอใช้  = 2 
ปรับปรุง  = 1 

แบบสังเกตพฤติกรรมกำรท ำงำนกลุ่ม 
 



เฉลยแบบฝึกหัดหน่วยท่ี 9 

ตอนที่ 1 จงท ำเครื่องหมำยวงกลมล้อมรอบตัวเลือกที่ถูกต้องท่ีสุด 
1. ภาพที่เกิดจากการเรียงซ้อนกันหลายๆ ชั้น  
 ก. Scene    ข. Layer 

 ค. Stream    ง. Playhead 
2. ส่วนใดที่ใช้ควบคุมการแสดงภาพเคลื่อนไหว 
 ก. ไทมไลน์    ข. เฟรม 

 ค. เลเยอร์    ง. ซีน 
3. เลเยอร์ประกอบไปด้วยกี่สถานะ 
 ก. 2 สถานะ    ข. 3 สถำนะ 

 ค. 4 สถานะ    ง. 5 สถานะ 
4. ข้อใดคือประโยชน์ของการซ่อนเลเยอร์ 
 ก. เพ่ือลดพ้ืนที่ในการทำงาน  ข. ไม่ต้องการให้เกิดการแก้ไขภาพโดยบังเอิ 

 ค. เพ่ือแสดงเฉพาะโครงร่างของภาพ ง. เพื่อกำรแก้ไขเนื้อหำที่สะดวก 
5. วิธีการใดท่ีจะช่วยจัดการในกรณีท่ีชิ้นงานมีเลเยอร์มาก 
 ก. ทำการล็อกเลเยอร์   ข. ท ำกำรซ่อนเลเยอร์ 

 ค. สร้างโฟลเดอร์เพ่ือจัดเก็บ  ง. ทำการแสดงเฉพาะโครงร่างออบเจ็กต์ 
6. วิธีการใดท่ีจะช่วยจัดการในกรณีท่ีชิ้นงานมีขนาดให่เกินไป 
 ก. ทำการล็อกเลเยอร์   ข. ทำการซ่อนเลเยอร์ 

 ค. สร้างโฟลเดอร์เพ่ือจัดเก็บ  ง. ย่อมุมมองที่แสดงเลเยอร ์
7. ถ้าหากต้องการกระจายเลเยอร์จะต้องเลือกใช้คำสั่งใด 
 ก. Distribute to Layers   ข. Insert Frame 

 ค. Convert to Blank Keyframes  ง. Insert Blank Frame 
8. ข้อใดไม่ใช่ลักษณะของการสร้างภาพเคลื่อนไหวแบบทวีน 
 ก. ไม่ต้องกำหนดข้อมูลทุกเฟรมเอง  ข. ระบุข้อมูลทุกเฟรมด้วยตนเอง 

 ค. โปรแกรมคำนวณและสร้างเฟรมอ่ืนๆ ให้ ง. เป็นวิธีการสร้างภาพเคลื่อนไหวที่เร็วมาก 
 
 
9. คำสั่งใดท่ีใช้เมื่อต้องการเปลี่ยนคีย์เฟรมเป็นคีย์แทรกระหว่างกลาง 



 ก. Distribute to Layers   ข. Clear Keyframe 

 ค. Convert to Blank Keyframes  ง. Insert Blank Frame 
10. คำสั่งใดท่ีใช้เมื่อต้องการเปลี่ยนคีย์แทรกระหว่างกลางเป็นคีย์เฟรม 
 ก. Distribute to Layers   ข. Insert Frame 

 ค. Convert to Blank Keyframes  ง. Insert Blank Frame 

ตอนที่ 2 จงอธิบำยถึงวิธีกำรจัดกำรเฟรมตำมรูปแบบต่อไปนี้ 
1. การแทรกเฟรม 

 . การแทรกเฟรมทำได้โดย คลิกขวาตำแหน่งเฟรมที่ต้องการและเลือกคำสั่ง Insert Frame เพื่อเพิ่ม
เฟรมแทรกระหว่างกลาง หรือกดคีย์ลัด <F5> (อีกวิธีคือคลิกเลือกตำแหน่งเฟรมและเลือกคำสั่ง Insert-
>Timeline->Frame ก็ได้) 
2. การลบเฟรม 

 การลบเฟรมทำได้โดย คลิกขวาเลือกคีย์เฟรม/เฟรมแทรกระหว่างกลางที่ต้องการลบ (เลือกทีละหลาย
เฟรมก็ได้) และเลือกคำสั่ง Remove Frames (อีกวิธีให้คลิกเลือกเฟรม กดคีย์ <Shift+F5> หรือเลือกคำสั่ง 
Edit->Timeline-> Remove Frames ได)้ 
3. การย้ายตำแหน่งและการก็อปปี้เฟรม 

 การย้ายตำแหน่งและการก็อปปี้เฟรมทำได้โดย คลิกลากเฟรมไปยังตำแหน่งที่ต้องการบนไทมไลน์ได้
เลย ซึ่งจะอยู่บนเลเยอร์เดิมหรือต่างเลเยอร์ก็ได้ ถ้าที่ตำแหน่งปลายทางมีเฟรมอยู่แล้ว เฟรมนี้จะไปทับข้อมูล
เดิม 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 

 

1. สำระส ำคัญ/ควำมคิดรวบยอด 

ในบทที่ผ่านมาเราได้เกริ่นไปแล้วว่าการสร้างภาพเคลื่อนไหวใน Animate นั้นทำได้อยู่ 3 วิธี คือ การสร้าง
ภาพเคลื่อนไหวแบบเฟรมต่อเฟรมที่เราต้องระบุข้อมูลทุกเฟรมด้วยตนเอง และการสร้างภาพเคลื่อนไหวแบบ
ทวีน ซึ่งเราเพียงกำหนดบางเฟรมที่สำคัญเท่านั้น ส่วน Animate จะคำนวณและสร้างเฟรมอ่ืนๆ ให้เองโดย
อัตโนมัติ และการเคลื่อนไหวโดยการใส่กระดูก  

 

2. สมรรถนะส ำคัญของผู้เรียน 
 2.1  ความสามารถในการคิด 
    -  ทักษะการคิดวิเคราะห์ 
    -  ทักษะการคิดอย่างมีวิจารณญาณ  
 2.2  ความสามารถในการใช้ทักษะชีวิต 
    -  กระบวนการปฏิบัติ 
    -  กระบวนการทำงานกลุ่ม 
 2.3  ความสามารถในการใช้เทคโนโลยี 
 
3. คุณลักษณะอันพึงประสงค์ 
 1. มีวินัย 
 2. ใฝ่เรียนรู้ 
 3. มุ่งม่ันในการทำงาน 
 

4. ชิ้นงำน/ภำระงำน (รวบยอด) 
 แบบฝึกหัดท้ายบท 
 

5. กำรวัดและกำรประเมินผล 

หน่วยกำรเรียนรู้ที่ 5   
เร่ือง   กำรสร้ำงงำนแอนินเมชั่น 

 กลุ่มสำระกำรเรียนรู้วิทยำศำสตร์และเทคโนโลยี 
ชั้นมัธยมศึกษำปีที่    5       เวลำเรียน  8  ชั่วโมง 

 



17.  ค้นคว้าหน่วยการเรียน 
18.  อธิบาย ยกตัวอย่าง 
19.  แสดงวิธีการปฏิบัติในแต่ละหัวข้อการเรียนและให้นักเรียนปฏิบัติไปพร้อมกัน 
20.  สรุปบทเรียน 

 
6. กำรจัดกิจกรรมกำรเรียนรู้ 

 ก่อนเรียน 
ค้นคว้าความรู้เรื่องการสร้างงานแอนิเมชั่น  

 ขณะเรียน 
33. ทำแบบฝึกหัดก่อนเรียน โดยการถาม – ตอบ และให้แสดงความคิดเห็น 
34. จดบันทึก สาระการเรียนรู้  
35. ร่วมกันสรุปบทเรียน พร้อมบันทึกผลการสรุป แล้วลุกขึ้นนำเสนอกับครูผู้สอน 
36. ผู้เรียนและครูผู้สอนร่วมกันประเมินข้อสรุปของผู้เรียน ที่ออกแสดงความคิดเห็นเพื่อให้ได้ข้อสรุปที่

ถูกต้อง  และครูผู้สอนแสดงความชื่นชมกับผู้เรียนทุกคนที่ออกแสดงความคิดเห็นและมีส่วนร่วมใน
กิจกรรมที่มอบหมาย 

37. ทำใบงาน  ตรวจสอบใบงาน แก้ไขใบงาน 
38. ทบทวนเนื้อหา 
39. ทำแบบฝึกหัดหลังเรียน 
40. ร่วมกันเฉลยแบบฝึกหัด 
 

7. สื่อ/แหล่งกำรเรียนรู้ 
1.  หนังสือประกอบการเรียน วิชา สร้างงานแอนิเมชั่นด้วย Animate 
2 .ใบงานประจำหน่วยการเรียนรู้แต่ละหน่วย 
3 . แบบฝึกหัดประจำหน่วยการเรียนรู้ 
4 . ตัวอย่างแฟ้มสะสมชิ้นงาน 
 
 
 
 
 

8. วัดผลประเมินผลประจ ำหน่วย 



13. สังเกตผู้เรียนมีความสนใจ เกิดความเข้าใจในสาระการเรียนรู้ ตลอดจนแสดงความกระตือรือร้นใน
การแสดงความคิดเห็นและสรุปสาระการเรียนรู้ประจำหน่วย  

14. ทำใบงานได้อย่างถูกต้อง  ทันเวลาที่กำหนด  ใบงานสะอาดและเป็นระเบียบ 
15. ผู้เรียนทำแบบฝึกหัดหลังเรียนได้ถูกต้อง  โดยได้คะแนน   50%  เป็นอย่างต่ำ 

 

9. กิจกรรมเสนอแนะประจ ำหน่วย 
17. ผู้เรียนต้องให้ความสนใจในการศึกษา  เพื่อหาเทคนิค วิธีการ หรือหลักการง่ายเพื่อให้หาคำตอบ

ได้อย่างถูกต้อง และรวดเร็ว โดยการ ตั้งใจฟังหลักการ เทคนิควิธีการที่ครูผู้สอนสรุปในขณะที่ทำ
การสอน และนำข้อสงสัยซักถามครูในการเรียนทุกครั้งที่เกิดความสับสน และไม่เข้าใจ 

18. ผู้เรียนมีการทบทวนบทเรียน ตลอดเพ่ือเสริมสร้างความเข้าใจอย่างแท้จริง 
19. ผู้เรียนหมั่นทำใบงาน แบบฝึกหัด และแก้ไขข้อที่ผิดให้ถูกต้องเสมอ 
20. ผู้เรียนต้องสร้างมโนภาพให้เกิดความคิดรวบยอดในสาระการเรียนรู้และเทคนิควิธีการพร้อมกับ

ความจำเป็นในการนำไปประยุกต์ใช้ให้เกิดขึ้นโดยตนเองให้ได้เพื่อเกิดความรู้ความเข้าใจอย่าง
แท้จริงไม่ใช่เกิดจากการท่องจำ 

 
 
   
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 



 

 
 

ล ำดับ
ที ่

ชื่อ – สกุล 
ของผู้รับกำร

ประเมิน 

ควำมร่วมมือ 
กำรแสดง

ควำมคิดเห็น 
กำรรับฟัง

ควำมคิดเห็น 
กำรต้ังใจ
ท ำงำน 

กำรร่วม
ปรับปรุง

ผลงำนกลุ่ม 

รวม 
20 

คะแนน 
4 3 2 1 4  2 1 4 3 2 1 4 3 2 1 4 3 2 1 

                       
                       
                       
                       
                       
                       
                       
                       
                       
                       
                       

 
      ลงชื่อ...................................................ผู้ประเมิน 

                                                                               ............../.................../................ 
 
 
 
 
 
 
 

 
 
 

 

เกณฑ์กำรตัดสินคุณภำพ 
ช่วงคะแนน ระดับคุณภำพ 

17 – 20 
13 – 16  
9 – 12  
5 – 8  

ดีมาก 
ด ี

พอใช้ 
ปรับปรุง 

 

หมำยเหตุ     ครูอาจใช้วิธีการมอบหมายให้หัวหน้ากลุ่ม 
เป็นผู้ประเมิน  หรือให้ตัวแทนกลุ่มผลัดกันประเมิน   
หรือให้มีการประเมินโดยเพ่ือน  โดยตัวนักเรียนเอง  
ตามความเหมาะสมก็ได้ 
 

เกณฑ์กำรให้คะแนน 
ดีมาก  = 4 
ด ี  = 3 
พอใช้  = 2 
ปรับปรุง  = 1 

แบบสังเกตพฤติกรรมกำรท ำงำนกลุ่ม 
 



เฉลยแบบฝึกหัดหน่วยท่ี 10 

ตอนที่ 1 จงตอบค ำถำมต่อไปนี้ 
1. จงอธิบายขั้นตอนวิธีการสร้างแอนิเมชั่นของลูกบอลกระทบบนพ้ืนซึ่งเป็นการสร้างแอนิเมชั่นแบบเฟรมต่อเฟรมอย่างคร่าวๆ 
 ขั้นตอนวิธีการสร้างแอนิเมชั่นของลูกบอลกระทบบนพ้ืนทำได้ดังนี้ 

 ขั้นตอน 1 กำหนดเลเยอร์พื้น และสร้างพื้นเป็นเฟรมภาพนิ่ง 

ขั้นตอน 2 สร้างเลเยอร์ลูกบอล  

ขั้นตอน 3 กำหนดให้ลูกบอลเคลื่อนไหวทีละเฟรม  
ขั้นตอน 4 ทดสอบผลที่ได้ 

 
2. จงอธิบายวิธีการสร้างแอนิเมชั่นของลูกบอลเคลื่อนท่ีซึ่งเป็นการสร้างแอนิเมชั่นแบบทวีนอย่างคร่าวๆ 
 เพื่อให้การเคล่ือนไหวดูสมจริงมากยิ่งข้ึน 
 
3. การเคล่ือนไหวชนิดทวีนแบ่งเป็นกี่แบบ แต่ละแบบมีลักษณะต่างกันอย่างไร 
 . วิธีการสร้างแอนิเมชั่นของลูกบอลเคลื่อนที่ซึ่งเป็นการสร้างแอนิเมชั่นแบบทวีนทำได้ดังนี้ 

ขั้นตอนท่ี 1 กำหนดเลเยอร์พื้น และสร้างพืน้เป็นเฟรมภาพนิ่ง 

ขั้นตอนท่ี 2 กำหนดเลเยอร์ลูกบอล 

ขั้นตอนท่ี 3 กำหนดคีย์เฟรมหลักท่ีใช้ในการเคลื่อนที่ของลูกบอล 

ขั้นตอนท่ี 4 ให้โปรแกรม Animate ทำการคำนวณการเคลื่อนที่และแทรกเฟรมเอง 
ขั้นตอนท่ี 5 ทดสอบผลท่ีได้ 
 
4. จงอธิบายวิธีการสร้างเอฟเฟ็กต์ภาพเคล่ือนไหวด้วยมาสก์เลเยอร์อย่างคร่าวๆ 
 การเคลื่อนไหวชนิดทวีนแบ่งเป็น 2 ลักษณะด้วยกัน 

1. การเคลื่อนไหวแบบเคลื่อนที่ออบเจ็กต์ หรือโมชั่นทวีน (Motion Tween) ใน Animate CS4 สามารถเลือกการทวีน
ลักษณะนี้ได้ 2 แบบ คือ แบบ Motion Tween เป็นการทวีนใน Animate CS4 สำหรับผู้ที่ไม่คุ้นเคย ก็สามารถกลับไปทวีน
แบบเก่าได้  เรียกว่า Classic Tween ซึงใช้ใน Animate ตั้งแต ่CS3 ลงไป   

2. การเคลื่อนไหวแบบเปลี่ยนแปลงรูปทรงออบเจ็กต์ หรือเชฟทวีน (Shape Tween) 
5. จงอธิบายขั้นตอนการปรับปรุงแอนิเมชั่นแบบทวีน อย่างคร่าวๆ 
 การปรับปรุงแอนิเมชั่นแบบทวีนทำได้ดังนี้ 

 ขั้นตอน 1 ปรับให้รูปทรงของลูกบอลสะท้อนการกระเด้งเมื่อปะทะกับพ้ืน 

ขั้นตอน 2 เพิ่ม/ลด จำนวนเฟรม เพื่อให้การเคลื่อนไหวดูสมจริงยิ่งข้ึน 

ขั้นตอน 3 ลดความเร็วของลูกบอลเมื่อเคลื่อนที่ไปได้สักระยะหนึ่ง 



ขั้นตอน 4 ทำให้ลูกบอลเคลื่อนที่เป็นเส้นโค้งโดยใช้โมช่ันไกด์ 
 
6. เราสามารถนำมากก์เลเยอร์มาใช้กับงานแอนิเมชั่นได้อย่างไรบ้าง จงอธิบาย 

 เราสามารถนำมาสก์เลเยอร์มาสร้างเป็นเอฟเฟ็กต์หรือประยุกต์เป็นทรานสิช่ันแบบต่างๆ โดยใช้เชฟทวีนแปลงรูปร่าง 
หรือเคลื่อนไหวออบเจ็กต์ที่มองทะลุในมาสก์เลเยอร์โดยใช้โมช่ันทวีนก็ได้ 
 
7. จงอธิบายวิธีการสร้างเอฟเฟ็กต์ภาพเคล่ือนไหวด้วยมาสก์เลเยอร์อย่างคร่าวๆ 
 . วิธีการสร้างเอฟเฟ็กต์ภาพเคลื่อนไหวด้วยมาสก์เลเยอร์ทำได้ดังนี้ 
 1. เตรียมภาพท่ีต้องการให้ถูกบดบัง  
 2. สร้างเลเยอร์ใหม่ขึ้นมา แล้วสร้างส่วนท่ีต้องการใช้บดบังหรือมาสก์ข้ึนมา  

3.  คลิกขวาท่ีเลเยอร์ใหม่ (เลเยอร์ที่ต้องการสร้างให้เป็นมาสก์เลเยอร์) แล้วเลือก Mask 
 4. เมื่อเลเยอร์นั้นกลายเป็นมาสก์แล้ว ให้สังเกตความเปลี่ยนแปลงของภาพบนสเตจ จะสังเกตว่าวงรีที่เราสร้างไว้ จะ
เปิดเป็นช่องปล่อยให้ภาพสุนัขที่อยู่ด้านล่างลอดออกมา และส่วนท่ีอยู่นอกเหนือวงรี จะมองไม่เห็นอะไรเลย 
 
 

 

 


